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1. Minimum System Requirements

· 3-D Graphics Accelerator* 
· A 100% Windows® 95/98 compatible computer system (Including compatible 32-bit drivers for CD-ROM, video card, sound card and input devices) 
· 200 MHz Pentium® processor 
· 64 MB of RAM 
· US Version of Windows 95/98 Operating System 
· Requires DirectX® 7.0 (included) or higher 
· Requires 500 MB of uncompressed disk space for game files,  plus an additional 100 MB for the   Windows swap file 
· Quad Speed CD-ROM drive (600 K/second sustained transfer rate) 
· 100% DirectX 7.0 compatible sound card 
· 100% Microsoft® compatible mouse and driver 
· 100% Windows 95/98 compatible joystick (optional) 
· CD Audio (Redbook) support 
· Multiplayer Requirements 
       - Internet (TCP/IP) and LAN (TCP/IP) play supported 
       - Internet play requires a 100% Windows 95/98 compatible 28.8 Kbps (or faster) modem 

* 3-D Graphics Accelerator Required 

A 100% DirectX 7.0 or higher compliant 3-D video card and driver is required. 
Battlezone 2 uses Microsoft's Direct 3D to support 3-D hardware acceleration. 
It has been tested on many but not all of the major cards. Some 3-D accelerator card brands utilizing the chipsets whose logos appear on the box may not be fully compatible with the 3-D acceleration features of Battlezone 2.  If your 3D card is not on the list, please visit http://www.activision.com

Battlezone 2 supports the following:

· 3DFX Voodoo               · 3DFX Banshee                 · Matrox G400 

· 3DFX Voodoo 2             · ATI Rage 128                 · nVidia Riva TNT 

· 3DFX Voodoo 3             · Matrox G200                  · nVidia Riva TNT 2 


NOTE: Battlezone 2 uses Microsoft DirectX 7 technology, and requires that your system have the most updated Windows 95 or 98-compatible drivers for CD-ROM, video card, sound card, and input devices.

Battlezone 2 may have trouble working with some 1993 or earlier Matsushita CD-ROM drives. 
These CD-ROM drives have trouble reading beyond 63 minutes on CDs, and Battlezone 2 uses the full CD.  These drives were sold under the names of Panasonic, JVC, Reveal, Creative Labs and Plextor. 
Gameplay may occasionally slow down and the CD-ROM drive will be accessed constantly. 
We highly recommend that you upgrade to a newer CD-ROM drive to avoid problems with other programs in the future.

A. Important Note on Multiplayer Host Machines

As with all peer-to-peer multiplayer games, it is very important that the multiplayer host machine be the fastest and most powerful of the group. The host machine not only has to run the game, but it has to keep track of all the people playing in it. This extra burden can be demanding on the host's CPU. A higher end host machines will make for a more satisfactory gaming experience. If a system is close to the base minimum required to run the game in single player, it may not have enough resources to run the game and handle the host responsibilities.



2. Processors

Battlezone 2 is optimized for Intel Pentium-class processors. 

Note about AMD Processors: Due to the lack of solid floating point processors, AMD processors may not provide a satisfactory gaming experience.  Battlezone 2 is optimized for Intel processors, and may not function properly on AMD processors. 

Cyrix Processors are not supported.

For further information, please refer to the minimum system requirements. 



3. Hard Drive Space

In addition to the 500 MB of hard drive space required for installation, you will need approximately 100 MB of free hard drive space when you run Battlezone 2.  This is to account for any swap files that Windows needs to create, as well as for saved games. 



4. CD Checking

In order to play Battlezone 2, you must have the CD in your CD-ROM drive at all times.  DO NOT remove the CD at any time while playing the game, or the game may crash.



5. Video Issues

In order to play Battlezone 2, we strongly recommend that you verify that you are using the latest video drivers from your manufacturer. We have enclosed a list for your convenience.  Please check the video card manufacturer's list for further information.

A. List of Supported Video Cards

The following video cards and chipsets were tested and are supported by Battlezone II:

NOTE: This is a partial list based on the information available to us at this time. The information is subject to change as new cards are released.

ATI Technologies Inc.
ATI Rage 128
   *ATI RAGE FURY (see notes)

3Dfx
Voodoo Graphics
   *Canopus Pure3D (see notes) 
   *Diamond Monster 3D (see notes)
   *Orchid Righteous 3D (see notes)
Voodoo Rush
   *Intergraph Intense 3D Voodoo
   *Jazz Adrenaline Rush
Voodoo 2 Graphics
   *3dfx V2 1000 
   *Canopus Pure3D II (see notes)
   *Diamond Monster 3D II  (see notes)
Voodoo Banshee
   *Creative Labs 3D Blaster Banshee 
   *Diamond Monster Fusion (see notes)
   *ELSA Victory II 
  *Guillemot Maxi Gamer Phoenix  
Voodoo 3 Graphics
   *3dfx Voodoo 3 2000 
   *3dfx Voodoo 3 3000

NVIDIA 
RIVA TNT 
   *Creative Labs Graphics Blaster RIVA TNT  
   *ELSA ERAZOR II 
   *Hercules Dynamite TNT 
   *STB Velocity 4400 
RIVA TNT2
   *Creative Graphics Blaster TNT2
   *Diamond Viper V770
    *Elsa ERAZOR III 
RIVA TNT2 ULTRA
   *Creative Graphics Blaster TNT2 ULTRA
   *Diamond Viper V770 ULTRA
   *Guillemot Maxi-Gamer Xentor 32
GeFORCE 256
   *Creative 3D Blaster Annihilator (see notes)

MATROX 
Matrox G200
   *Matrox Millennium G200  
Matrox G400
   *Matrox Millennium G400 32MB 


The following cards or chipsets are unsupported by Battlezone II with the currently released manufactures drivers:

ATI Technologies Inc.
ATI RAGE PRO (see notes)

NVIDIA 
RIVA 128/ZX
   *Diamond Viper V330 (see notes)
   *STB Velocity 128 (see notes)
   *STB Velocity 128ZX (see notes)


Notes:

At the time of this document’s creation, there were graphic anomalies observed with the following graphic cards:

ATI RAGE PRO: These anomalies involve clipping and terrain issues. It was observed by QA that this problem was alleviated with the use of ATI Rage PRO Special Purpose Driver.  These drivers can be obtained by visiting http://www.atitech.com


ATI Rage 128: These anomalies are isolated to the radar grid not being present.  It was observed by QA that this problem was alleviated with the use of ATI Rage 128 Special Purpose Driver.  These drivers can be obtained by visiting http://www.atitech.com


3dfx Voodoo Graphics: These anomalies include extreme graphical glitches, sound corruption, and unstable game play.  It was observed by QA that this problem was alleviated with the use of 3dfx reference drivers.  Please read the note below about reference drivers below before installing them.  These drivers can be obtained by visiting http://www.3dfxgamers.com

The Voodoo Graphics chipset is featured on the following video cards:
Canopus Pure3D
Diamond Monster 3D
Orchid Righteous 3D


3dfx Voodoo 2: These anomalies are isolated to the radar grid not being present.  It was observed by QA that this problem was alleviated with the use of 3dfx reference drivers.  Please read the note below about reference drivers below before installing them.  These drivers can be obtained by visiting http://www.3dfxgamers.com

The Voodoo 2 chipset is featured on the following video cards:
3dfx V2 1000
Canopus Pure3D II
Creative 3D Blaster Voodoo2
Diamond Monster 3D II
Orchid Righteous 3D II


Diamond Monster Fusion:  These anomalies include blocky terrain, grids appearing on shadows, and slow performance.  It was observed by QA that this problem was alleviated with the use of 3dfx reference drivers.  Please read the note below about reference drivers below before installing them.  These drivers can be obtained by visiting http://www.3dfxgamers.com


Nvidia Riva 128/ZX: These anomalies include blocky terrain, grids appearing in the sky, and slow performance.  It was observed by QA that this problem was alleviated with the use of Nvidia 128/ZX reference drivers.  Please read the note below about reference drivers below before installing them.  These drivers can be obtained by visiting http://www.nvidia.com

The Nvidia Riva 128/ZX chipset is featured on the following video cards:
Diamond Viper V330
STB Velocity 128
STB Velocity 128ZX

Creative Annihilator (GeForce 256): Accessing resolutions of 1280x960 and 1280x1024 in 16 bit color or 32 bit color may result in a black screen at game launch. 


**Note on reference drivers**
Video and Sound Cards are a combination of a core chipset and additional electronics added by the card manufacturer to implement special features outside of the capabilities of the core chipset (i.e. S3/Diamond uses the Voodoo 2 chipset by 3Dfx as the core of their Diamond Monster 3D II video card). 

Reference drivers are provided by the chipset manufacturer for the card manufacturer; the card manufacturer (i.e. Creative Labs, S3/Diamond…etc) then uses these drivers as a starting point in creating their supported release drivers. In the process of creating these supported drivers, a card maker typically debugs and optimizes the reference drivers, as well as adds enhanced utilities and features specific to their card.

It is not always a safe assumption that the reference drivers are the best drivers for your card, since some of the features added by the manufacturer of the card may require a substantial change in the reference drivers before they will work on the card.  Reference drivers are unsupported, may not work properly on your hardware, and do not contain the enhanced features and utilities often provided by board makers. Use at your own risk.

You are almost always better off with the supported drivers provided by your card manufacturer. These drivers have been thoroughly tested and optimized on your exact hardware, and are backed by a dedicated support staff. But occasionally new release drivers lag the reference drivers by several months. If an application or game you wish to run requires certain features or bug fixes that have not been incorporated into the release drivers yet, your only resort may be to use the reference drivers. You should switch back to the supported release drivers as soon as they have been brought up to date.

Battlezone II does not support video or sound card reference drivers. Activision Customer Support cannot provide assistance with the installation and removal of Reference Drivers.  It is suggested that supported DirectX 7 drivers be used. We do note where we have seen improved stability and performance in the reference drivers as an indication of what should be available when that version of the reference drivers is integrated into your manufacturer's drivers.



6. Sound Issues

At the time of this document’s creation, there were certain sound cards that had noticeable audio anomalies.  It was observed by QA that these problems were alleviated with the use of reference drivers.  Please read the note below about reference drivers below before installing them.

Aureal Vortex 1
*Turtle Beach Montego I (see notes)

Aureal Vortex 2
*Diamond Monster Sound MX300 (see notes)

Notes:

Turtle Beach Montego 1:  These anomalies are isolated to repeating or looping sounds. Updated reference drivers can be obtained by visiting http://www.a3d.com/newa3d/index.asp

Diamond Monster Sound MX300:  These anomalies are isolated to repeating or looping sounds. Updated reference drivers can be obtained by visiting http://www.a3d.com/newa3d/index.asp



7. Joystick Issues

A	Setting up your Joystick

1. To set up your joystick to work in Battlezone 2, in Windows, go to the Start menu and choose Settings / Control Panel. 
2. Double click on the Joystick icon. 
3. Find the option for your joystick from Joystick selection. Confirm that Current joystick is Joystick 1. Also, check the box for Rudder if it is applicable for your joystick. 
4. Go through both the calibration and test sequences for the joystick. Make sure that everything is working properly. If you have ANY problems while calibrating or testing the joystick, the joystick will not work properly in the game. After successfully completing both steps, click on the Apply button. If you do have problems when calibrating or testing the joystick, a number of things can be going wrong. The joystick might not be working properly, the game port that the joystick is plugged into might have a problem, or it may be a problem with Windows. You may want to contact the manufacturer of the joystick for troubleshooting tips.

B	Throttle Issues

If you have a joystick with a throttle control and wish to bind the throttle to a forward/backward movement, you need to make sure the throttle is fully set to the middle prior to running Battlezone 2, otherwise the throttle will only work in one direction.



8. Transferring Saved Games Between Machines
Follow the directions below to reuse saved games: 
1.	Uninstall Battlezone 2. 
2.	Copy the files and folders that are not uninstalled to a floppy disk. These are your saved games and settings files. 
3.	Re-install Battlezone 2. 
4.	Delete the Save directory from the newly installed Battlezone 2 directory. 
5.	Copy the files and folders from the floppy into the Battlezone 2 directory. 
6.	Launch the game. 
7.	You should be able to load your old games from the Load Game Screen at this point. 

NOTE: Copying saved games from one computer to another is NOT SUPPORTED by Activision.



9. 3rd Party Technical Support

Technical support for GameSpy(c), HEAT.NET™, and Earthlink(c) is provided by GameSpy, HEAT.NET, and Earthlink respectively, not by Activision.



10. Multiplayer

Battlezone II supports four players on a modem server, and six players on a local area network server.

Support
Activision does not provide multiplayer support by phone.  If you have need of assistance, contact Activision Customer Support by email in English only at support@activisionvalue.com. 

Team-Play 
The Multiplayer game for Battlezone 2 supports a unique ability to play cooperatively in Deathmatch and Strategy modes. In Deathmatch, teams can be configured for either straight Deathmatch play or Capture the Flag. For the Strategy Mode, 4 players are supported in 2 teams of 2. During team-play Strategy mode, one player (the Commander) is responsible for setting up the base and building, while the other player provides basic battle and combat support.  You may determine each player's role in the team options window before launch.
About Firewalls
If your Internet connection is behind a firewall, you may experience problems connecting to multiplayer games. Please consult your Internet Service Provider for more information. 
Modems and LANS
If you have a modem game set up, it is possible for a LAN player to see the game but be unable to join due to firewall issues.

Connecting to a Multiplayer Game through a Network using a Proxy Server.

Currently, Battlezone 2 does not support multiplayer games through networks running proxy server programs such as WinGate or Sygate. Users who wish to manually configure their proxy servers should use ports 17770 and 17771 to attempt to allow games to be played. Activision does not provide support for problems encountered from manually reconfiguring these settings.



11. Troubleshooting

Activision thoroughly tests its games on a variety of systems before they are released, but it is virtually impossible to test on all combinations of software and hardware.  Many of the issues you may encounter in Windows 95/98 are caused by device drivers for video cards, sound cards, and CD-ROM drives that are not fully compatible with the Windows 95/98 operating system and/or DirectX. The following troubleshooting tips are intended to assist you in resolving some of the common issues that occur with the Windows 95/98 operating system and the game.

A. AUDIO

IMPORTANT NOTE: You may encounter choppy gameplay if your sound card is not 100% DirectX 7 compatible. 8 bit sound cards are not supported with this game (e.g. Sound Blaster and Sound Blaster PRO compatible). Also, the following sound cards may not fully support DirectX:

Yamaha OPL3 series 
AD (Analog Devices) 
Sound 2 
Ensoniq (Gateway 2000) 
IBM's MWAVE 
Compaq's ESS 

You may want to contact your sound card manufacturer to see if your card is 100% DirectX 7 compatible.
Most sound card problems are remedied by obtaining newer sound card drivers (usually maintained for free download on the hardware manufacturers web site). This is highly recommended and easy to do. Visit your sound card manufacturer’s website for details.

B. AUTOPLAY

If you insert the Battlezone 2 CD in your CD-ROM drive and the game title screen does not appear, try performing the following steps:

With the disc in your CD-ROM drive, double-click My Computer on your desktop, or right-click it and select the Open option. In the View pull-down menu, select Refresh.  Double-click the CD icon in the window or right-click it and choose the AutoPlay option. 

After the game title screen appears, click Play 
(There will be an Install button instead if you have not installed the game). 

If the title screen still does not appear, please check the following: 

Make sure the CD is clean and properly placed in the CD-ROM drive. 
Verify that your CD-ROM driver is optimized for use with Windows 95. 
a. Right-click the My Computer icon and then choose Properties.
b. Click the Performance tab.
c. If any of your hardware drivers are not fully optimized for use with Windows, they will be listed here with an explanation of the problem and suggestions on how to fix it.
d. If you cannot get your system to perform optimally, please consult Microsoft support.

Verify that the Auto-Insert Notification for your CD-ROM is enabled. To do this: 
a. Right-click the My Computer icon and then choose Properties.
b. Choose the Device Manager tab in the dialog box.
c. Double-click CD-ROM.
d. Select your CD-ROM drive and click Properties.
e. Select the Settings tab of the Properties dialog box.
f. Make sure the Auto-insert notification box is checked. If not, click it to make it checked.
g. Click OK to accept your changes.

Double-click the My Computer icon on your desktop. Select the Refresh option located in the View pull-down menu of your system window. When the game icon appears, double-click it. The game title screen should appear. 

If for some reason you do not wish to use AutoPlay, you can turn it off using the following steps: 

Right-click the My Computer icon and then choose Properties. 
Choose the Device Manager tab in the dialog box. 
Double-click CD-ROM. 
Select your CD-ROM drive and click Properties. 
Select the Settings tab of the Properties dialog box. 
Make sure the Auto-insert notification box is unchecked. If not, click it to make it unchecked. 
Click OK to accept your changes. 

Note about AutoPlay: If you eject the CD during gameplay and re-insert it, you may experience slowdowns and/or desktop crashes as the CD launches the Battlezone 2 Splash screen. To avoid this, make sure to keep the CD in the drive at all times.  

C. CD-ROM
If you encounter any CD-ROM drive problems, make sure you have the latest 32-bit CD-ROM drivers installed. Most problems are the result of having 16-bit CD-ROM drivers. To see if your computer is using 16-bit drivers, follow these steps:
1. Right mouse click My Computer
2. Choose Properties
3. Select the Performance tab
If File System does not state "32-bit", then you need to update your CD-ROM drivers. Please contact your CD-ROM drive manufacturer for details.

D. DIRECT X
During the game setup, the installation process will determine if Microsoft DirectX 7 needs to be installed on your computer. If so, the Microsoft DirectX 7 setup program will install the appropriate files on your computer. If you choose not to install DirectX 7, and you find that later you need to install it, you can click the Install DirectX button from the game's Autoplay screen, under the Help section.
Who makes DirectX and how can I contact them?
Microsoft created DirectX. If this help file does not answer your DirectX questions, you may want to contact Microsoft via mail at:
Microsoft Customer Sales and Service
One Microsoft Way
Redmond, WA 98052-6399, USA
Microsoft can also be reached in the USA at (800) 426-9400, or internationally at +1(206) 882-8080.
Microsoft's DirectX web site is located at: http://www.microsoft.com/DirectX/Default.asp
What is DirectX and why do I need it?
Microsoft DirectX 7 is an API (Application Programming Interface) that increases the speed at which games play under the Windows 95 operating system. These APIs allow direct access to the enhanced features of hardware under Windows 95. With DirectX 7, a program has instant access to the hardware, allowing for great advances in graphics, sound, video, 3D, input and network capabilities of games.
DirectX is relatively new in the computer world and provides many features not anticipated by the creators of some older hardware. As such, some hardware drivers have not achieved compatibility with it yet. Many manufacturers are releasing updated drivers to meet the DirectX standard. If you are not sure about your video or audio card's compatibility, consult the vendor list and contact the company that makes your video or audio card.
If the Microsoft DirectX Installer does not detect DirectX 7 on your computer, it will install DirectX 7 for you. After installation is complete, you will need to restart your computer in order for DirectX 7 to take effect.
If you have other Windows 95 games on your computer, chances are you already have an earlier version of DirectX installed on your computer. In this case, the Microsoft Installer will overwrite that version with DirectX 7. The DirectX installation process will then be complete. You will need to restart your computer for the changes to take effect.
If you already have DirectX 7 installed on your computer, the Microsoft DirectX 7 installer will detect it and not overwrite any DirectX 7 files. In this case, you may not need to restart your computer after installation in order to run the game. The installer may prompt you to replace old video card drivers. If you do not replace the drivers, Battlezone 2 may not run properly.
DirectX 7 should not affect any titles designed for the earlier versions of DirectX. Should you encounter difficulties with DirectX 7, please contact Microsoft for further information.
How do I check to see if my computer supports DirectX?
1.	Open the Start menu and click on Run. 
2.	Type "DXDiag.exe" (without the quotation marks) in the space provided and press the Enter key. 
3.	Check each of the sections of DXDiag for any driver files that are labeled as not certified. 
If any of the components of DirectX are not certified, please call your hardware manufacturer for the updated drivers that support DirectX.
 
I am having problems running the game and think it might be related to my DirectX installation. What should I do?
Execute the DirectX diagnosis tool, DXDiag (as described above). If all drivers are certified, run all tests on each tab. If your drivers fail any of the tests, please contact your hardware manufacturer for assistance in correcting your driver issues. Otherwise, contact Activision's Customer Support. (support@activisionvalue.com)
 
I have heard DirectX is not compatible with some video or audio cards. What can you tell me about this?
DirectX is relatively new in the computer world and provides many features not anticipated by the creators of some older hardware. As such, some hardware drivers have not achieved compatibility with it yet. Many manufacturers are releasing updated drivers to meet the DirectX standard. If you are not sure about your video or audio card's compatibility, consult the Vendor List and contact the company that makes your video or audio card.
 
If I don't have DirectX, will the game install it for me?
Yes. If the Battlezone 2 Installer does not detect DirectX on your computer, it will start Microsoft's DirectX Setup program for you. After installation is complete, you will need to restart your computer in order for DirectX to take effect.

E. INSTALLATION

Can I run the game on Windows 3.1, Windows NT or OS/2? 
This game supports Microsoft Windows 95 and Windows 98.
The following operating systems are NOT supported:
·	Microsoft Windows NT 
·	Windows 3.xx 
·	MS-DOS 
·	IBM OS/2 (All Varieties) 
·	UNIX (All Varieties) 
 
Can I install the game to a compressed hard drive? 
We do not recommend installing this program to a compressed drive. Please install to a non-compressed drive and run the program from there.

I have a AMD K6 processor, and I am experiencing problems during installation. 
Battlezone 2 is optimized for Intel processors, and may not function properly on AMD processors. 

I have a Cyrix 6x86 (or other Cyrix processor), and I am experiencing problems during installation. 
Battlezone 2 is optimized for Intel processors.   The game has been tested on Cyrix processors, and slower performance has been observed.  It does, however, still function properly.

I have a NexGen Pentium compatible processor, and it is not being detected correctly within the installation process. What do I do? 
There are no NexGen Processors that are within the minimum system requirements for this game.

The installation window disappeared and the screen went blank. How can I fix this? 
Sometimes the screen will minimize during installation. You can correct this by using Alt+Tab (hold down Alt and press Tab once), or by clicking the appropriate item on the taskbar.
I uninstalled the game and there is no option to re-install the game (i.e. I can only choose play as an option). What should I do? 
If you have uninstalled the game and there is no option to reinstall it, it usually means that, due to an error during uninstallation, the Windows registry thinks the game is still installed. Please call Customer Support for guidance on re-installing the game.
Will a virus checker affect the way Battlezone 2 installs? 
Due to the large number of files in the game installation, users of Norton AntiVirus® and other virus checking programs may experience extremely long install times if the virus checking program is active when installing the game. If this is the case, you can first scan the CD for viruses (for your peace of mind), disable your virus checker, install Battlezone 2, then re-enable your virus checker.
Here’s a response from a representative at Norton AntiVirus, "Follow these steps for temporarily unloading the NAV AutoProtect agent from memory:
1.	Click Start -> Programs -> Norton AntiVirus -> Norton AntiVirus 
2.	When the NAV window opens, click 'Options' 
3.	Then click on the Auto-Protect tab 
4.	Remove the checkmark from the line 'Load AutoProtect at Startup' 
5.	Click 'Ok'. Then click on 'Yes' to the message that appears 
6.	Close Norton Antivirus 
At this point, Nav AutoProtect is unloaded from memory. You may now install your new checkmark back in Load AutoProtect at startup and click 'Ok'.

F. VIDEO CARDS
Most video card problems are remedied by obtaining newer video card drivers. This is highly recommended and easy to do. 
Contact your video card manufacturer for details.
Note: Battlezone 2 does not support video card reference drivers. It is suggested that code released DirectX 7 compliant drivers be used.
Playing in 32-bit Color Mode
Battlezone 2 supports 32-bit color mode. If your graphic card supports it, you may select this ability in the Graphics options screen in the game and in the shell..
Installing a New Video Card
If you install a new video card into your system after you have installed the game, you may need to uninstall and reinstall the game in order to get it to properly recognize the new hardware. Be sure to uninstall using the uninstaller; other methods of deleting the game are not recommended.
Brightness Settings
You can change your brightness settings in the Battlezone 2 shell. Select the Graphics Menu option and slide the mouse to your desired level.


12. Miscellaneous Problems & Solutions

A	How can I improve performance?
1. Close all other programs while playing. 
·	Close all programs that appear on the task bar. 
·	Press CTRL-ALT-DEL to pull up a list of programs that are still running at this point (but not on the task bar). 
·	Close all unnecessary programs by using the "End Task" button for each. 
Note: In our experience the only necessary programs are "Explorer" and "Systray." You should, however, check with the computer manufacturer to ensure that their machines do not require other programs to remain active as well.

2. Set Graphics Acceleration to maximum in your System Control Panel. 
·	Go to the Start menu on your taskbar. Select Settings->Control Panel. 
·	Double-click the System icon. 
·	Click the Performance tab. 
·	Click the Graphics button. 
·	In the Graphics box, position the Hardware Acceleration slider to Full. 

B	The taskbar hides a portion of the game window. Can I fix this?

This can happen if your taskbar is always on top. You can hide the taskbar by right-clicking it and selecting Properties. Turn on Auto Hide and turn off Always on top. The taskbar will hide when it is not used. To make the taskbar reappear, place your mouse in the area where the taskbar once was and it will appear.

C	The screen goes black and freezes when I launch the game.
DirectX: We have found this to be the case when you do not have DirectX certification. In most cases you can fix this problem by updating your video card drivers. This is highly recommended and is usually free and easy to do. You can contact your Video Card Manufacturer for details.
This can also be a result of having the incorrect video adapter or monitor selected. To correct this:
1.	Go to the Start menu on your taskbar and select Settings->Control Panel. 
2.	Double-click the Display icon, select the Settings tab. 
3.	Click the Change Display Type (if you have OSR/2 this reads "Advanced Properties") button. 
4.	From the Change Display Type dialog box, confirm that the adapter type matches the card you have installed in your computer and that the monitor type matches the monitor you are using. If these are incorrect, click the Change button. 
5.	In the Select Device dialog box, choose the correct video adapter or monitor. Click OK. 
6.	In certain cases, you will need to insert your original Windows 95 CD in order to load the appropriate driver. 
7.	After Windows 95 corrects your graphics adapter settings, it will ask you to restart your computer. Click Yes and allow the computer to restart. 
8	Upon completion of this process, uninstall the game, then reinstall it.

D	I’m experiencing sorting problems.

Some objects may appear to be sorting improperly in the game. Consult your vendor about the video card’s Z-buffer capability, and if new drivers are available that will allow the card to handle sorting issues more effectively.
 
E	The Display Options dialogue box looks funny, with anomalous gray borders.
If you notice anomalous gray borders on your Display Options Box, this is likely caused by the fact that you are using Large Fonts.  To switch to a standard Windows font size, right-click on the desktop, choose Properties, choose the Appearance tab, and change the setting under the menu labeled Scheme.
F	My screen saver operates slowly while the game is running. What can I do?

Due to the game’s heavy use of the system resources, screen savers may hinder game performance. We highly recommend disabling your screen saver while playing Battlezone 2.

G	Why does the game sometimes quit to the desktop?
Occasionally, the game will suddenly quit to the desktop. This may be a result of a conflict with the EZDesk desktop utility that is used to organize icons on your desktop. To prevent this, disable EZDesk before playing the game. If you ever crash to the desktop, you should reboot the machine and perform a scan disk if necessary.
The game may also suddenly minimize to the taskbar if you are running an electronic mail program (e.g. MS Exchange) in the background. To avoid this, we recommend you run Battlezone 2 as a stand-alone application.

H	Ctrl-Alt-Del locks up my system.

If you use the Ctrl-Alt-Del function, there is a chance that the machine may automatically reboot, or you may get a "blue screen crash," which will force you to reboot your machine. Do not use the Ctrl-Alt-Del function to quit the game. Instead, select ABORT from the main menu to exit the game.

I	I just selected “Windowed” mode from the Graphic Options screen. How do I return to full-screen mode?

If you enter “Windowed” mode, you will have to quit Battlezone 2 and restart if you want to return to full-screen mode.

J	Where do I go for game updates and/or patches?

You may check our web page for updates to your game at: http://www.activisionvalue.com
If you are uncertain of a game update and/or patch, please e-mail all questions to our Internet mailing address at: support@activisionvalue.com 

Note: Updates and/or patches are available in English only.



13. Addendum to Manual and other Last Minute Issues

A	Manual Addendum

·	Page 16 of the Battlezone 2 Manual 

Under the 'Main Menu' heading beneath ‘File,’ the manual says:

"This allows the player to save the current game or to load previously saved games."

It is actually not possible to save games in the Main Menu version of the File Menu (you can load games from there, however). You can load and save games from the File Menu while playing a game.

·	Page 18 of the Battlezone 2 Manual

‘Accelerate Mouse’ and ‘Mouse Sensitivity’ are no longer accessible from the main options screen. It is instead possible to change the directional sensitivity for your mouse / input device in the ‘Movement’ heading under ‘Input Options.’

·	Page 48 of the Battlezone 2 Manual

The description for the Scion "blink" device in the BZ manual states that "The device will teleport you a random distance in the direction you are facing," though this is not entirely correct.
The blink device teleports the user to any SPECIFIC location pointed with the provided green targeting spotlight.

·	Page 54 of the Battlezone 2 Manual.

The ‘Troubleshooting’ section mentions several options to access online help, whereas the correct methods to get online help are from the title screen under ‘Help,’ and from the Start menu, by selecting Programs/Battlezone II/Battlezone II Help.

B	Resolution in the Shell

Despite which resolution and color depth you set Battlezone 2, the in-game shell will automatically revert back to 640x480, 16 bit color

C	Pausing the Game

Hitting Alt-P or Pause on the keyboard will temporarily suspend play.

D	About “Texture Size” in the Graphic Options

Texture size is analogous to “Texture Detail” - the higher size, the better quality the models in the game will appear. Higher texture size, however, requires a more powerful computer and video card. We recommend keeping texture size to “low” for maximum performance unless you have a high-end video card that can support larger textures.

E	Mission-Related Issues

ISDF Mission 2

At the very start of this mission, after you tell the service truck to follow you, if you race to the first jammer and destroy it and the two scouts before Shabayev tells you to help her with the last one, the mission may not proceed. If you wait for Shabayev to instruct you, the mission should proceed normally.

ISDF Mission 4

If the sniper rifle gets destroyed, you will be unable to complete the mission. If this happens, you will have to restart the mission and try again.

ISDF Mission 11

Although the first objective in this mission is to get to Nav 1, if you travel to Nav 1 through the enemy base, the mission will not continue until you proceed to the second recycler, numbered “2” on the map.

F	Capture the Flag Issues

Occasionally during a CTF game, after the ship carrying the flag is destroyed (before reaching home), the flag will be left up in the air, making it necessary to jump (E key) to get your ship to run over and reclaim it. 

G	Multiplayer and AMD Processors

If you have an AMD Processor, setting up a new game in Multiplayer and passing your mouse over the “Select Map” list may cause the “Allowed Vehicles” list to reset. 

H	Bombers

During gameplay, if you happen to lose your Bomber Bay, you will also lose your bomber. If the bomber is currently on a bombing run and the Bomber Bay is destroyed, the bomber will complete its mission before disappearing in a puff of logic. 

I	Map Boundaries

ISDF and Scion vehicles are quite agile, and it is possible to get them stuck in crevices near certain boundaries on the map. If this ever happens to your vehicle during a mission, you will have to restart the mission and try again.

J	Non-Functional Consoles in Buildings

Certain buildings, such as the ISDF Training Facility and Bomber Bay, have consoles inside them, but they are non-functional.

K	Changing your Pilot in Multiplayer

In some cases, leaving a game and returning with a different pilot will not change the pilot’s name to reflect the new pilot. If this happens, we suggest quitting and restarting the game.

L	Sniped Vehicles and Friendly Pilots

If you successfully snipe an enemy ship but wait for a friendly pilot to occupy the vehicle, the friendly will take the vehicle, but you will be un
